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The Gross Profit Margin, Operating Profit Margin, and Net Profit Margin are all essential profitability indicators. They are frequently used to contrast the performance of the same company over time or between different companies. In this article, I will show you the processes to calculate the Gross Profit Margin, Operating Profit Margin, and Net
Profit Margin in Excel. Calculate Profit Margin.xlsxBefore starting the procedure, let’s introduce you to our dataset for this article. Here is a list of the financial statements of a company (column A) and the mention of their corresponding cost (column B).Below the data table, I will calculate the profit margins in a separate row.Gross Profit MarginWhat
is Gross Profit Margin?Gross Profit Margin is an economic ratio that calculates the percentage of profit a company makes from its total earnings. The Gross Profit Margin is helpful to measure a company’s financial health.To calculate the Gross Profit Margin, subtract the total price of raw materials of a company from the total revenue. Then simply
fractionate the result by the total revenue.Calculate Gross Profit Margin in ExcelNow before showing you the method, I should mention that there is no built-in function for calculating the Gross Profit Margin in Excel. That’s why to calculate the Gross Profit Margin, we are going to follow the standard equation of Gross Profit Margin.The formula to
calculate gross profit margin, Gross Profit Margin= (Total Revenue - Expense on Raw Materials)/Total Revenue So, the formula to apply in Excel for calculating gross profit margin is,= (B2-B3)/B2Here,B2 indicates the value of Total Revenue.B3 denotes the total Expenses on Raw Materials.To calculate gross profit margin in Excel, follow these
steps:Select an empty cell. To enter the formula, I'll use cell B5.Now, type the formula in cell B5.Press ENTER to insert the formula.Select cell B5.Click on the Home tab.In the Number group, hit on the % button.The Gross Profit Margin of our dataset is 43%.0Operating Profit MarginWhat is Operating Profit Margin?Operating Profit Margin is a
measure of profitability that measures a company’s ability to generate profits from its core operations.To calculate the Operating Profit Margin, first, deduct the total cost of operating costs and raw elements from the total revenue. Then fractionate the result of subtraction by the total revenue. Finally, express the result in percentage.Calculate
Operating Profit Margin in ExcelTo calculate the Operating Profit Margin, only the cost of operating costs and raw elements are taken into consideration and they are subtracted from the total revenue.The formula to calculate operating profit margin, Operating Profit Margin = (Total Revenue - Expense on Raw Materials - Operating Cost)/ Total
RevenueThe formula to apply in Excel to calculate operating profit margin,= (B2-B3-B4)/B2Here,B2 indicates the value of Total Revenue.B3 is the Expenses on Raw Materials.B4 represents the Operating Cost.To calculate the operating profit margin in Excel, follow these steps:Select an empty cell. I will be using cell B6 to insert the formula.Write the
formula in cell B6.Press ENTER.Click on the % icon in the Number group of the Home tab.Normally, the Operating Profit Margin is represented in percentage form. So, it is best to use the percentage (%) here.Net Profit MarginWhat is Net Profit Margin?Net Profit Margin expresses the amount of net income or profit generated as a percentage of
revenue. The Net Profit Margin calculates the percentage of revenue that remains after all operating and non-operating expenses like debts, interests, and taxes, etc. have been paid.Calculate Net Profit Margin in ExcelThe Net Profit Margin considers all types of expenses for its calculation.The formula to calculate net profit margin, Net Profit
Margin= = (Total Revenue - Expenses on Raw Materials - Operating Cost - Other Expenses)/Total RevenueTo apply this formula in Excel,=(B2-B3-B4-B5-B6-B7)/B2In the above formula,B2 is the inflow of money. It is the total amount of revenue.B3, B4, B5, B6, and B7 are different sorts of outflow of revenue.To calculate net profit margin in Excel, go
through the steps below:Type the formula in an empty cell. I've inserted the formula in cell B9.Write the formula in cell B6.Press ENTER.Now hit the % icon under the Number group of the Home tab.So, you can see all types of expenses are subtracted to find the Net Profit Margin. Here I have to mention that, the additional expenses can vary in other
cases.Conclusionl hope now you have a clear concept of the 3 types of profit margin calculation in Excel. I hope this article will help you to solve any sort of situation regarding profit margin. Please visit our Blog page for more Excel-related articles like this one. Feel free to share your thoughts about our articles in the comment section below. Thank
you!Frequently Asked QuestionsHow do you do margins in Excel?To set margins in Excel, follow these steps:Click on the Page Layout tab in the Excel ribbon.In the Page Setup group, click on Margins.Select one of the predefined margin options (Normal, Wide, Narrow) or click on Custom Margins for more control.If you choose Custom Margins, a
dialog box will appear. Enter the desired margin values for the top, bottom, left, and right margins.Click OK to apply the selected margins to your Excel worksheet.Setting margins in Excel is essential for controlling the layout when printing or previewing your spreadsheet. Adjusting margins helps ensure that your data is appropriately formatted on
the printed page.How to calculate profit in Excel?To calculate profit in Excel, use the formula: Profit=Revenue—Expenses Here’s a step-by-step guide:In your Excel worksheet, input the revenue value in one cell (e.g., Al) and the expenses in another cell (e.g., B1).In a new cell, enter the formula: =A1- B1. This subtracts expenses from revenue to
calculate profit. For example, if your revenue is $50,000 (in cell A1) and expenses are $30,000 (in cell B1), the formula =A1-B1 will give you a profit of $20,000.This simple formula enables you to quickly determine profit in Excel by subtracting total expenses from total revenue.Related Articles Knowing your profit margin is one of the simplest ways to
understand if your business is truly making money. Many business owners turn to Excel to work out their profit margins — and it’s a great tool for getting started. In this guide, we’ll walk you through exactly how to calculate profit margin in Excel, step-by-step. Plus, if you're looking for a faster, real-time way to track profits automatically, we’ll
introduce a smarter solution you might love.Calculating your profit margin in Excel can be simple once you know the formulas. Here's a quick step-by-step guide you can follow:First, you need to find your profit. The basic formula is:Profit = Revenue - Cost of Goods Sold (COGS) - Other ExpensesExample: Revenue: $2,000,000 COGS: $700,000 Other
Expenses: $500,000 Profit = $2,000,000 - $700,000 - $500,000 = $800,000Next, calculate the profit margin by dividing your profit by your revenue.Profit Margin = (Profit + Revenue) x 100Example: Using the numbers above:Profit Margin = ($800,000 + $2,000,000) x 100 = 40%Don’t want to calculate it manually? Learn how to calculate profit
margin in Excel to streamline the process. By setting up your data properly, you can automate profit margin calculations and save time.To automate your profit margin calculation in Excel, you can set up your data like this:Profit margin formula set-up in ExcelFinally, format the Profit Margin cell (Column E) as a Percentage in Excel to display the
result properly.You can set up profit margin formulas in Excel—and now you know how. But if you'd rather skip the spreadsheets Try our free profit margin calculator.It does the math for you, instantly and accurately, so you can focus on what really matters: growing your business.Excel is a fantastic tool when you're just starting out. It's flexible,
customizable, and gives you full control over your numbers.But as your business grows, keeping track of profit margin in Excel can become surprisingly tricky.Here are some common challenges many businesses run into: Manual data entry can lead to human errors: A small typo in one cell could throw off your entire calculation without you noticing.
No real-time updates: Every time your costs, sales, or expenses change, you need to manually update the spreadsheet. It’s easy for data to get outdated fast. Dynamic costs are hard to track: If your ad spend, shipping fees, or supplier costs fluctuate daily, keeping your profit calculations accurate in Excel can feel like a full-time job. Managing multiple
products and platforms adds complexity: Selling across sale channels means juggling different reports—and pulling it all into one sheet can quickly get overwhelming. It becomes time-consuming as you scale: What once took a few minutes can turn into hours of manual work every week, pulling you away from bigger growth opportunities. If you're
finding Excel harder to manage as your business scales, you're not alone. The good news? There's an easier way to stay on top of your profits—without the manual hassle.Anatomy of a high-converting product pageWant 6-7% Add-to-Cart rates? Shopify expert Lila has hit those numbers for years with one proven formula—and now it’s yours in a single
cheatsheet.As we said earlier, Excel relies on manual updates—and no matter how careful you are, one missed input or formula slip can throw off your entire profit margin analysis.TrueProfit solves that.TrueProfit is a Shopify profit tracker app that is built for businesses that want accurate, real-time profit data. With TrueProfit, your net profit margin
is powered by smart cost tracking and seamless automation.With TrueProfit, you’ll unlock even more advantages that Excel simply can’t offer: Real-time updates: TrueProfit syncs with your store, ad platforms, and shipping tools—so your profit numbers are always accurate, without manual updates. Accurate cost tracking: Track real-time COGS by
product, region, or variant. TrueProfit pulls cost data directly from your tools and lets you customize it your way. Net Profit insights: See your true net profit—per product, per order, per store—automatically, without second-guessing. Financial health, at a glance: All your key numbers in one clean dashboard: profit margin, revenue, COGS, ad spend,
and net profit. Want to skip manual spreadsheets and see your real-time profits? Try TrueProfit free today.Once you've set up gross margin, you can take it further by calculating net profit margin, which includes operational and marketing costs. Check out our guide on how to calculate net profit margin.Excel is great for calculating profit margin
when you're just starting. But as your business scales, it gets harder to track true profit manually. A smarter tool like TrueProfit automates your profit tracking in real time—factoring in COGS, shipping, ad spend, and more. You save time, reduce errors, and make faster, data-backed decisions. If you're ready to move beyond spreadsheets, it's time to
switch to a tool built for ecommerce growth. For each of the three methods in this tutorial, we’ll assume that you’'re working from the following dataset of a clothing store with their selling price and the cost. Method 1 - Use an Excel Formula to Calculate Gross Profit Percentage Gross profit is the simplest form of profit. We just deduct the cost of the
product from the total revenue, and we get this. We do not consider other costs of business in this profit margin. It is a preliminary profit idea. Add two more columns to your table to show profit and percentage. Go to Cell E4 and enter the following formula. Drag the Fill Handle icon. You'll get the profit by subtracting cost from revenue. Go to Cell F4
Then type the below formula. Double click the Fill Handle icon. You can see that we’ve got the results in decimal form. Now, we will convert this value into percentage form. Select all the cells of the Percentage column. Choose the Percentage (%) format from the Number group. Look at the result and you should see the Gross Profit Percentage.
Method 2 - Calculate Operating Profit Percentage in Excel We will get the Operating profit by deducting the operating cost and the cost of the product from the revenue. The operating cost includes transportation, the salary of employees, rent, marketing costs, and maintenance costs. The total operating cost is also known as SG&A. The formula for
Operating Profit is as follows: In the below dataset, we have different operating costs from the product cost. Steps: Go to Cell C11. Type the following formula. Press Enter to get the result. We get the total operating cost here. We will find out the operating profit by subtracting the cost of goods and operating costs from the revenue. Type the
following formula into Cell C12. To divide the profit by the revenue, enter the following formula into Cell C13. Method 3 - Determine Net Profit Percentage in Excel Net profit is determined after deducting all the tax and interest along with the remaining costs from your revenue. Steps: We have tax and interest in our dataset. And the operating cost
already calculated. Determine the profit by subtracting the tax, interest, and other costs. Type the following formula into C14. Press the Enter button to execute. Go to Cell C15. Enter the following formula: Hit the Enter button to convert the result into a percentage. Download Practice Workbook Download this practice workbook to exercise while you
are reading this article. Calculate Profit Percentage.xlsx



